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bRt RIEFAIENBIREP ZFE D RZFHME,

11
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34 EHEH

EHEGHAK:
1. FEMBEAGiL EHEY THFENMED:

EEELt

Schaeffler SmartWeb

ER!

B#EXCH : smartcheck-ato1-SCHAEFFLER-1 160 20191203_142241-670129 572 B .
2. milE AR EEES S,
3. ATHAE, HRAFMEMEHSEHSmartCheck &4 ProLink ¥4, M BUEAI X ME O, MARITERIER, .

o FEEHEMI B % LRI A N ERRMNEEXHM TR 2K, FIEEEHALEL SmartUtility
g BHTHRINERBEMEE, #MIF U0 RERMIEREIEEMHRES, EERE &
WFHRTH,

o BEFAIRERFALIL S B, FEIX BRI IR SmartCheck 244 ProLink 1+ £ LED SKRAEKTRE BN
HERNAE, ARLUT/IRREER:

o A15HTFF SmartCheck ZE 4. ProLink 1 % B H E 45,
o AE#FF SmartCheck Z4. ProLink ¥ 4% B LAR M,
o WHEETEREH.
NP LEFREEEEHR, RS RIEER!
o MBEFEBEGFHLNHI T — DB R, M AHE 8 LER RN MESRE 35 E 4R
AASHER > RARER.

o WIRBHITEHSER, 5 FLZN NS Cache, N T FHIEHIN W23 0% ZFARAR Schaeffler
SmartWeb #, XRHNLE,
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32 EBEERWL
ERERRE

1. ERBFEAPEFERFERBRZLT, FTHENMED:

EREREE

Schaeffler SmartWeb

2. MIEFEFIFR Ak H A S B4 i -
EFEIRE BT LT E S SmartCheck 4. Prolink ##%
o FrhiTHENE,
o EAMINEHIE. BEMEHREFLRL,
B3hi% %’ Maintenance &id kI E S %% A0 Maintenance System, 75X B A] LIk EI| £ EAIIRFEIRE, Hrp

System DIEEHEH. RREENRA &AM, ks, 7 Maintenance System iR RIHEIEE %
HHE TR,

FAG SmartChed:: -» Maintenance System

Maintenance System

@ Update firmware % Reset data parition Reset firmware

— ! 5 Download debug log &
— m m
—— Adjustsystem setlings files ﬁl Open expert menu
1 Backup system t Restore system ® Reboot system
— p S — Y ¥
Version: 1.0.20 (Build: 394380-20180815221038) Firmware 1.12.0 will start automatically in 9:58 minutes.

MERAFEEEHE 9, WEESHI—DERXIHE, ER

tﬂ BELUE T 5 B3 F S 1 5 B A0 & 5t Maintenance System,
BEE B LENEERIEDX:
b pe S . FANENEMEE X,
o EHFIEEE, RIERE T MIRERERFERL,
EyiRE i kIS SmartCheck 24, ProLink X4 B RE FHEHTRA
3 S HRA . FHENENEMEEX,

13
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3.

o MBRFIERAE T HIRE WA,

o FEEREEX.

o EHHETEHAERRE,

ALLEMIERTE. RETHWIREREMNEE, AE2 7 & AERRESHER
SmartUtility & T2 EREEFERE . REFHRZERE2EBENARES, MERE
—EBHETERTE, TR EXHRE2RE, FAaT LUBIGFTE XY IP #hilki)in] Schaeffler
SmartCheck 4. ProLink # %,

RGHATE, ERAFTEAILD S f1SmartCheck B4 ProLink &4, Mt BUHAI X AE O, MAHATERISH. .

TEHRAITT R W%, FHEREETIE .

g

3.3 AMFENHESE A AIEA

SmartWeb %4 i 5 L0 Ty BE T B MEANVF BT 1 8%V BT UE 4L, 51 30 3T LA {5k FRBR ANV BT 5 B A F i F AR @S @ | o, 1
A AR 3R . FF B ATE VR E B R AR AR ANV RIE SRV AT IE AL, R R B R R B AT F A RHIE B B AR

THEAT FF VT A E E B 85 -
IFrRIEEES X
e pina=1:d BHERAE BUEILAE
Channel Monitoring 2020-08-01 2021-01-01
Email 2020-09-01 2021-01-01
CPCIUA 2020-08-01 2021-01-01

i
A
i

IEATFE AL B R TR & SmartCheck 24, Prolink B ERIVFRNIESIR R LI TER:
WRIHER FE ML AT VF RIIE R FR, B FRaR Rl VF RTHIE T /S AR ThRE . RTRERIVF R IER MR H P E A

BIZHREIN T :

o EEMWM:ERANEFESEIRIEELN 70

o OPC/UA:iZF1f#F OPC UA fR%25:@ 15858 128
o ELFHBME: MBAER L F I BIEEE] o

o Schaeffler Cloud : 12 f1{# A Schaeffler Cloud 5&15 @& LL & 5 1] Schaeffler
Cloud/ 6,

AR ZEE R RV RNEMARHATE R

XA BT A0 VF RTIE S VY RIE A

1.

vk

EH B S ch e BT IRV R BB SR 0 00, LMEITHMNMEO,

Bl RINR, HIAMFAHESRE T AHEAE A,

TE XA Y 2 @ i FEF IR R 3R TXT 4 mTE ST T 7
XA A 8 IR BT AR

EE ORISR R 8 m o id D0 F ol {IE B F 8 al 1IE 28 F MBIV R U ST RS
EXARRETAHN—FKER, NIERMEE X FENXEB 3R RlEF0 v el ik 4 ro

o
iy



ck

A/ Rm

IR ER A T AES

Schaeffler SmartWeb

ECEH=TH EETEEEETITHELNE, FMEAESEHUETEE .
=7xml version="1.0" encoding="UTF-8"7=
<syn-LicenseDefinition xmins-si="http:ifwww w3 org/2001XMLSchema-instance”™ xmins:syn="http:/ffis-services de/synergia™
xsi-noMamespaceSchemalocation="LicenseManagement.xsd™=
=gyn Licenses=
=gyn:License=
<syn:Properties=
=syn:ld=A515FF31-B993-451D-A000-000000000005</syn:ld>
=syn:Mame>Channel Monitoring=/syn:Name>
<=syn:Scope=
<syn:SerialNumber=F4:30:80:00-1C-99</syn-SeralNumber=
<isyn:Scope>
=syn:ValidUntil=2020-12-31T00:00:00Z=fsyn-ValidUnfil=
=/syn; Properties=

=<syn-Key=LBFVPJOKNXUCEhmComn fedCsiQqtWep//uwRIDTR 36w DcQndzoJdMM 6uxxmSY Gjgl GdréR Y viF d S Fww+i2 P2 1drCpH2kh 1HZemgLzuzn
tDGMVS4nEg+gP+jARVCgrag0Qj2oMZlsgUmzpwiglUkLJ2z AMIDIvPPriKmQLdAy9bddX GoY 4K2Cjaj3qKFhZWiggemUUKn UIXOxG +MZs2ATHp]
yovGMsXOMidiGrZidkZ+ Pw\WI4pilPYIKDbHAvoBoQLSLThKssORLWzJbr/9J 212 NdF 7 §Cze CmS O GDbmiclsdsabbkor2aYkVSNShS GyvkDxQxInxX WVITX
GZ0==</synKey=
=/syn:License>
=gyn:License>
<=syn:Properties=
=syn:ld=A515FF31-B993-4531D-A000-000000000007 </syn:ld=
=syn:Mame>Email=/syn:Name=
=syn:Scope>
<gyn:SerialNumber=F4:30:80:00:1C.99</syn:SenalNumber-
<isyn:Scope=
=syn:ValidUntil=2020-12-31T00:00:00Z<fsyn:ValidUnfil=
=/zyn:Properties=
<syn-Key=0Mbt5CtX5zJ5RadmVRo3BaX0aYm1s/D5F0/9t4 5K 4 FOglOIF CnAMbulKWAONGK3Tq421dkGowRTh/8KpggbZ RKPoe8GpY JgF zHsw2 +&

dNFVFLhjsgik3BKREMWC aTPkrT9jQ0tgFQOfy HUWPWISs GEIEHKY QY +cNSRapdMx0 SgWDju/wjTqZd DRy HnbDgv3SgUeny297tsr1 FGellkCOlwwl
OwSxVoBRWVoRK2g3r3jNDeS X GIQFcA122iP3NIGpFvO 3BbC 1 K/CIFsNd GaysApelMUroiTF Xe3LwaS SE/GVO I ZewLVm b TH/O TIIGCUZGIMVCD +
=

SDu2EMoGSDA===/synKey=

HET 0 -+FHATIEAN 8 +-FHEFIE.

6. iR, EVRHEEERRE 0800 BRAT RNV aHESE Va4,

mn

XA B AT R R HE
FEVFANEEERHRIEPARN AV EHE, R MBROF B R-HEERIL.

>
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3.4 £ Schaeffler R %
BN R ZEYF SmartCheck = ProLink ¥ & %32 Schaeffler TR, MHE—NMEREXH. ESHEXELRRS LA,

B3 5 Schaeffler =R HIEEN AKX
1. 7EEBhE ik Schaeffler &3 Cloud-Onboarding %5, LUETHMEMHME D

%4 Schaeffler Cloud-Onboarding

CRE—EETAREESchaeferCloud, (FEILIESEM HEEESHES, FibE, doud schaefllercom
O =5
2. miliER, ML REXH,
3. mili OK BIRI/E3) Onboarding i3 %8, miiBHRI X ME O, MARITERIER.

LIk B B 568 Schaeffler Cloud @158 (133 PUT AT RIB L MFTRRIAT A L E . BB DIHE Proxy ¥

&1,


https://www.schaeffler.de/content.schaeffler.de/de/news_medien/mediathek/publikationen/downloadcenter-global-pages/downloadcenter-language-list-publications.jsp?pubid=87649857&ppubid=87649858&tab=mediathek-pub&subfilter=app:dc

% % B Maintenance System

% % B9 Maintenance System
Schaeffler SmartCheck Z4. ProLink ¥ %-#J Maintenance System Rt & EAIRF=ThEE, FIANER RS H L EH, BE

SmartCheck 4. ProLinki% &S &R RABEH LERLG AR, thalERARKE— 1 ThEEK & ##% %, tkst, Maintenance
System L HIZME LML RINEE, LUEE S Maintenance System i MIB& SmartCheck 4. ProLink ¥ &% LB RS,

Maintenance System (iR #t ZE XA, 3037 F i % 10 B H B FTE, 15140 23 4 58 357 2 A it o] LUE i i B 28 B

$TF SmartCheck E 4. ProLink % #% Maintenance System FI5=
1. GEEMFEAPRFERERRAET, FTFENMED:

ERERRE

Schaeffler SmartWeb

2. IEMIERFIFR PIE LT B3 %/ Maintenance System,
3. AR, HI Maintenance System BIZFTE:

FAG SmartChed: -= Login Page

Maintenance System

T

Versicn: 1.0.20 (Build: 3824580-201680815221038) Firmware 1.12.0 will start automatically in 9:57 minutes.

4. |\ Login 1) #2411, $TFF Maintenance System BIE 1, d:&il Expert Menu o BAIEEEATRE R 27,
INER7E SmartCheck E4. ProLink E#hBGET AF B8, W AEI—FELME, GO IEREEABRILERANE
BR, ZRAAFHEENERITTFE I

17
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FAG SmartChedc -= Maintenance System

Maintenance System

Update firmware % Reset data partition Reset firmware

ol — : ) Cownload debug log ah
— Adjust system settings 5 Open expert menu
- justsy g L8 files -fp  Openew
" Backup system 1' Restore system @ Reboot system
H H
“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:58 minutes.

5. XL RAT—EbE, EFEAEN A DIRE MIDRETE, RAHITRS:S WEE— 1 FR ik FIRE. 5 Maintenance
System B INREH XMIEAEBIES I THET,

=1

¢ 237 Maintenance System i}, SmartCheck E4. ProLink & F#rrr A NIE !
e iTF Maintenance System BIEUIThEERT, AI7E4 £ A EE| Homepage B i, A, B

R [E|ZE Maintenance System BIE T,

¢ Maintenance System B2 — 4~ EN 230 EE: SR K AIRVELZ), MESBEINER RS, KERE

BURF 4L 7 Maintenance System 4. (&

= Maintenance System BB RTL:2 Rt ER

» Maintenance System BB ILFIFTERITIEEIL : 10 R B RER
s ERFHAPZFT Expert Menu: 60 H4f
IMATERTA RRHEER X SFIEIT RN H,

4.1 Update firmware: 5 $7 & 4
mili Update firmware (©] R, FRILITIEE, Al E R E SRR E RS L = BRI 28T

=1

EHEH

MBI IRATE, thal LUE A Z e A ESE — 1B IRME SRR, X FEAE R T th MR
MEHIE,

R ARRERERIDT:

e 1.10.0 ZHi# SmartCheck iR AELE ProLink fRA 1.18.0: FTLABEH EH HAIARA

e 1.10.0 Z2/5# SmartCheck iR AS;# ProLink M4 1.18.0: RAEEZ% = 1.10.0 2 1.18.0

1. fil Select file MW 1243t R EHFHEE M SF2 T,
2. $TFF SF2 i, RASH XA SMBET LTS, MBATLL, LRSI FhE 4 -



% % B Maintenance System

FAG SmartChedc -= Updste Firmware -» Select File

()
Update Firmware
Firmware file: (@ smartcheck-at91-FAG-1.12.2.20170502_164020-395886.512
I The selected file contains the firmware 1.12.2 (Build: 20170502_164020-395836). I
LATR U I UpIUal e T O CalCer 10 aoort
v X
“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:45 minutes.

IR R A A AR E SR, Tt 2 3B AR 5 E A,
3. s ok Y imHl FRES.

o EEHEMIN % LRI ERENS LK, BEMATRE LK, FILLAEFHANEL
!i SmartUtility i THINERFEMEE, BEF— U150, RAERMIRE N (EIEEMHARES, B
BEE—EHTHRTR,

o BEFAIRERFALIL S B, FEIX BRI IR SmartCheck 244 ProLink 1+ E# LED KK E BN
HEENAE RRLUT/IRREER:

o A15HTFF SmartCheck ZE 4. ProLink ¥ % B HLE 45,
o R5#FF SmartCheck Z4. ProLink ¥ 4% B LAIR M,
o WHEETEREH.
NP LEFREEEFHE, RS RIEER !
o MBEFEBEGHLNHI T — DB R, A 8 LER RN MESRE . 358 E 4R
AU BB > RAER

o WIRBHITEHER, HFLZN NS Cache, N T HIEHIN W23 M0 ZFRAR Schaeffler
SmartWeb ##, XRHNLE,

19
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4.2 Reset data partition: EE#HEH X
m i Reset data partition % R, FFE XTI, AIUELEERES X, It SHBFEREFAEMNEHE, NERE
RmETA,

s ok ¥ i, BEMESK.

4.3 Reset firmware: £ {5 &4

=i Reset firmware , FFRiZTiTheE, Al AEX B L EUE S X e 150 BR 2R SE O R RN S 82 & #0ll 2 80E, ¥
BixEEI)NNEEE,

mit ok Y il g HEE,

4.4 Adjust system settings: B R LR E
=i Adjust system settings = R, FTRERRGIRENEEMIR T :

FAG SmartChed: -= Adjust System Settings

»

Adjust System Settings

ﬂ] Edit system name

A Configure IPv4 settings

)

LI
@ Configure NTP server IOPF‘:E- Configure IPvG settings

|F&' Change administrator password E Replace server cerificate (PEM)

Version: 1.0.20 (Build: 394580-20180515221038)

RilTER—NMEHL, FTHFANMYRE. SERAXNERIES L TIET,

4.4.1 Edit system name: &R RZE A
mi Edit system name & 15241, % 0BhEE, ATLAE Y SmartCheck E4, ProLink 4 B — 5 &%,

mERGEBHIHAX
1. ¥ ARES NIEE SmartCheck E 4. ProLink & A#T 4 75



% % B Maintenance System

FAG SmartChedc -= Adjust System Settings -» Edit System Mame

»

Edit System Name

System name: FAG SmartCheck 36

Enter system name and click OK to save or Cancel to abort.

Wersion: 1.0.20 (Build: 394580-20160815221038)

2. sk ok ¥ AL BB

4.4.2 Configure NTP server: B2 i NTP R % 8

=i Configure NTP server © 124, FFRIZIThRE, AT LATELEIATE — 4 NTP AR%-28, SmartCheck Z4. ProLink 4 H]
LAMIZRR 55 88 3K BUR GL i 1] o

EZE NTP fR&3=MIA &
1. TEHAERHA NTP fR% 2509 IP #hibsk NTP fR%-235A 5

21
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FAG SmarnChed: -= Adjust System Settings -= Configure NTF Server

»

Configure NTP Server

NTP server: ntp.rhrk.uni-kl.de

Here you can configure an NTP server from which the system can load the
system time.

Enter the NTP server address and click OK to proceed or Cancel to abort.

Wersion: 1.0.20 (Build: 394580-20160815221038)

2. ik oK Y AL, A TP Hotibsk NTP BR% 224 7.

o INRMEMA NTP fR5#AH, WA DNS i 558 80& 1L DHCP EE.,

g" o MEARYE NTP BRS- S84 IE REENT 1), A RMFTRS . Eikt, SmartCheck Z4. ProLink %
DR BIYS, 3 B SR TTLA  NTP BR%-58, F Al RA %A .

4.4.3 Change administrator password: {& & & 2 R &Y
& Change administrator password C=7 s, R iTiEe, X B A E R SR G E A,

EREEAFELHAR
1. 7 Administrator password 1E % AFTEZH,
2. 7 Reenter password 1E B i AR :



% % B Maintenance System

FAG SmarnChed: -= Adjust System Settings -» Change Administrator Password

»

Change Administrator Password

1. ———— Administrator password: 11T}
2. =P Reenter password: seee

Here you can change the administrator password.
Note: Leaving the password empty will disable the user management.

Click OK to proceed or Cancel to abort.

“ersion: 1.0.20 (Build: 384580-201680815221038)
3. sk ok Y Al BAEED.

) MBEMA—NEEREN, UKE SmartCheck Z 4. ProLink %4 £ E#CER ) &I [ 142,
!; MRRFELRMA—NEE AE, WA SmartCheck E4. ProLink & L ZRARAEHE,

4.4.4 Configure IPv4 settings: B2 & IPv4 & &
sili Configure IPv4 settings # %41l I /5 % 1DhAE, BIZE R4 IPv4 K% 518,

ik IPv4 MK FBEMAR
1. M DHCP mode 3% F ik s DHCP &= :

23
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FAG SmarnChed: -= Adjust System Settings - Configure |Pva Settings

()
Configure IPv4 Settings
DHCP mode: DHCP: Send host name to serve «
Host name: FAGSmartCheck
IP address: 10.179.7.241
Netmask: 255.255.255.0
Gateway: 10.179.7.254
Name server:
Select the DHCP mode and configure the network settings for IPv4.
Click OK to proceed or Cancel to abort.
v X
“ersion: 1.0.20 (Build: 384580-201680815221038)
EE LTI
No DHCP FIFZE AT LUK RE IPv4 itk sk k2L A SmartCheck E4, ProLink &% #EK

A IP #bdlf,

IR EHFHE No DHCP, L b ZFZ b PITHERE, 4120 IP address,
Netmask 5% Gateway,

DHCP: Send host name to FIAZiE T SmartCheck E4. ProLink ¥ % 8] Bzh7E IGRIM 25 3k ER IP #hlk, 41

server £ ¥l SmartCheck 4. ProLink ¥4 7EM %% 8 DNS AR %525 &1,
DHCP: Load host name from F|fAiZik 7 SmartCheck &4, ProLink ¥ 48] Bh#E EAIM 4% ch3RER IP ik, il
server M%) DNS AR 22 BE EHL B

2. 41 DHCP mode %£#%ME, #7i7f Host name, IP address. Netmask. Gateway = Name serverli T EEE

B,
3. mit ok ¥ 4], EBOEREE R A RE R,

) o IR SmartCheck E4. ProLinkGerats # IP #ullk, 7 2 BRI T R aI B 4]
g' SmartWeb . AR AIFE X Vi BF P A FTRY e & bk, EHFE A EF Maintenance
System,

o HNREiT DHCP B34 EC IP #htik, MY A& Bah 4 ECfd IP #hik 88 3@ i F ML 75 (DNS) Vilnl
SmartCheck Z4. ProLink %%, ZEiF LA EREKIA IP Hhillt,

4.4.5 Configure IPv6 settings: B2 & IPv6 & &
il Configure IPV6 settings e 41, FE/2 % IIThAE, AL IPV6 W% W&,

4’k IPv6 M EM AR
1. M DHCP mode 3% F ik s DHCP &= :



% % B Maintenance System

FAG SmarnChed: -= Adjust System Settings - Configure |PvE Settings

()
Configure IPv6 Settings

DHCP mode: DHCP: Load host name from sert|

IP address: fed0::fo3d:80ff:fe00:1336

Netmask: 64

Gateway: 10.179.20.254

Name server:

Select the DHCP mode and configure the network settings for IPvE.
Click OK to proceed or Cancel to abort.
v X
“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:57 minutes.

EE LTI
No DHCP FIFZE AT LU RE IPv6 ik, sRE k4L SmartCheck E4, ProLink 5 % #EK

A IP #bdlf,

IR EHFHE No DHCP, L b ZFZ b PITHERE, 4120 IP address,
Netmask 5% Gateway,

DHCP: Load host name from F|fiZi% 5 SmartCheck 4. ProLink 4% 8] B Zh 7 RO 2% 31 ER IP #htik, @it
server M4 B DNS AR5 28 2 BLEH B,

2. % DHCP mode i:# Mm%, % F7EIP address. Netmask. Gateway = Name server’i T {5 E HE#1F.
3. it oK ¥ i, BBSEOHEE E R L ER L,

) o INEFEK SmartCheck E4. ProLinkGeréts B IP H#hilk, NI7E 2 BTt T A el &7 i)
g‘ SmartWeb %, SRR N Vg R A TR B & thit, EFHRA L,
o INEEiT DHCP B34 B IP bk, NN A @i B sh4r BLay IP it st&@id 414 # (DNS) 51
SmartCheck E4. ProLink 1%+, 2 F¥F A ERAE IP #hdit,

4.4.6 Replace server certificate (PEM): 5 # iR 55 28 iF

mi Replace server certificate (PEM) G B, FRiZIThEE, RS F|EPATFRIEE RS 25, AT LELEL—1
B 2 RIAR % Z/IE & SmartCheck E 4. Prolink &% ERF T BIBR S FIUE 15,

B SmartCheck 4 ProLink % & HR% BiF HHA

1. i Server certificate file W %413 1835 B EIR % 21F 189 PEM i,
2. $TFF PEM XX 3H7E BN/ 7E Passphrase E i A PEM i 48 2 555 -

25
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FAG SmartChedc -= Adjust System Settings -= Replace Server Certificate -= Seledt File

»

Replace Server Certificate

Server certificate file: i server2.pem

Passphrase: (111}

Click OK to upload the server certificate or Cancel to abort.

v X

“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:52 minutes.

3. mili OK v A, BRI RGO ST FHFE T LA TR B ST A @ A -

FAG SmartChed: - Adjust System Settings -= Replace Server Certificate -= Install

»

Replace Server Certificate

cert. wersiom - 1 F
=erial number : BB:C5:E€3:FA:-28:A3:52:8€
i==uer name : C=DE, 3T=EY, L=3chweinfurt, 0=3chaeffler Technologies GmbH & Co. EG, OT=—, -
CH=www . fag—=martcheck. com, emailBddress=industrial-services@schacffler. com 3
=ubject name : C=DE, 3T=E¥, L=3chweinfurt, C—3chaesffler Technologies GmbH &£ Co. K&, OU=—,
CH=www . fag—=martcheck. com, emailBddress=industrial-services@schacffler. com
i==ued om : 2016-07-14 08:27:02

- I09E-—nT-1% NE-27.07 b

The server certificate is ready to be installed.

Click OK to install or Cancel to abort.

v X

Versicn: 1.0.20 (Build: 3824580-201680815221038) Firmware 1.12.0 will start automatically in 9:48 minutes.

BT A A IR B, & X B A,
4. st oK Y iRHl TERRS B,



% % B Maintenance System

4.5 Download debug log files: T ;& f& B & X 4

mii Download debug log files B, FFRZIIThEE, AITELLCI B H T HMBER E X, ERATEELEFZX
o BTG R R EZRANTRIEARRS 0, AIEMREITH.

THASXHHAR

1. i oK Y imHl, FE8s R,
2. (ST HAIE B R I S S AR X TR
3. B RGIREE S, BT, SAUS AR BRI T A S e R B *.SCLG 3 B 7S X

4.6 Open expert menu: sTFLHRFEH

mii Open expert menu &1 B, FRRELREREBXER,

HEHEREAPAIHEIfES L Schaeffler SmartCheck Z 4, ProLink I #E A LB HIAE. BAXERENRAMEEZEXEE,
AN LB EA—REBLHREEREFITHALREY, SREEXEFEXNESERFS UL TIET,

ERRAREEREFNIAFAR
1. AEFEFHE N LE - ID, ATLLE I, tha] LUE IR ID HR A BA TR =D,

FAG SmartChed: -= Open Expert Menu -= Login

»

Open Expert Menu - Access Verification

This section is password protected. Please call the customer support to generate
a one-time password from this ID:
—_— fadbbc87
Click the button below to log into the restricted area. Enter the user and the
generated password for authentication. The password is valid until next system
reboot.

1

Wersion: 1.0.20 (Build: 394580-20160815221038)

2. HMBBAZFRDELZ ID £ ——RIEWTF KA E,

3. =il Login W szin, #7510 00, % User Name 1EsPHI AR %, 37 Password 1 A— I
Authentication Reguired @
0 A username and password are being requested by http://192.168.178.50.
The site says: "Web Server Authentication”
User Name:
Password:
[ oK l | Cancel |
4. mit ok Y L, HILEREAE T

27
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FAG SmartChed: -+ Open Expert Menu

»

Open Expert Menu

|E@' Reset administrator password D Start remote access senvice

& Replace cryptographic keys % Update Maintenance System

Clear entire system @ Reboot system

=1

Wersion: 1.0.20 (Build: 394580-20160815221038)

RTTER—NMEH, FTFENEHYEE, SEREASIMREXMERFS LTINEY,

o X E4F Maintenance System mif, ID Fl1— R MG F Hi, —BERE SmartCheck E4,
[i ProLink ¥4, ID fi&MEN%k %k, EE Maintenance System i, &8 —N#8Y ID, KT LUE L
MBARZFDDIRIR— 1 #HEL,

o EEXEFMEIA 60 HEN ], 2% AFEL AR HORE—REE, NRELLH

@i H41HE A Maintenance System FMBILBERIGERIEZZEFE L, NEMNBBEXRE
LZE 60 2%,

4.6.1 Reset administrator password: E & & & i 13

&7 Reset administrator password =8 %41, F5 nﬁrmm 7Eix B A LUSEE R B 8 6 E AN R A
ﬂLLH%F_Il«M'EHiMﬁ%ﬁi##ﬁ%’ﬁmﬂnﬂﬂﬁ Rt EARA S G,

s ok Y imen, g pEE R E,

{#F Change administrator password| 22) Ih&g, & EE 7 200, @i Maintenance System
lﬂ FxHtfy Adjust system settings %48 X IRE,

4.6.2 Replace cryptographic keys: = #: N % & £

=1 Replace cryptographic keys & w, FE ZINThEE, AN 2 7L A TR 1R E R 30 (*.SF2) #14%1% 3048 (*.SCBK)
AR INZE &3 X R0 B 530 . IR R MK BT TR, WaiE i, HIRETFI|RERS ERETER .

BEHmEERHAR

1. i Keystore W %403t 18 % B4 MBEHRASE
2. $TFXH:



% % B Maintenance System

FAG SmartChed: -= Open Expert Menu - Replace Cryptographic Keys -+ Seled File

()
Replace Cryptographic Keys
Keystore: [@FF smc-bkbin
Click OK to upload the cryptographic keys or Cancel to abort.
v X
“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:52 minutes.
3. Ry OK" B, BB BR, RS FFE R LR RSN & B
FAG SmartChed: -» Open Expert Menu -= Replace Cryptographic Keys == Install
F~N
(3]
Replace Cryptographic Keys
The cryptographic keys are ready to be installed.
Click OK to proceed or Cancel to abort.
v X
Versicn: 1.0.20 (Build: 3824580-201680815221038) Firmware 1.12.0 will start automatically in 9:45 minutes.

BT AEERMMERL, b2 e %A,
4. s ok Y imkl REHMMERLL,

4.6.3 Clear entire system: 5e £ & & 4t

=i Clear entire system ] ¥4l FFRZIIThEE, RIE B SR E 4 . B E DI 2 B E N EADN R4, Maintenance
System BIE EINEERZ 20,
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1. =i OK v B, MEREAN RS RABMER, BRI TIETR:

FAG SmartChedc -» Open Expert Menu -= Clear Entire Sytem

>

Clear Entire System

The system has been cleared successfully. You need to install a
new firmware.

MNote: Please configure the IP address, otherwise the system will

be reset to the default IP address "192.168.1.100" after reboot.

Wersion: 1.0.20 (Build: 294980-20180815221038)

2. NEBHRE—NTFEY, 5, TRHEFHEE SmartCheck 4. ProLink & &8 IP #itt, RAHEBIT HIURIEE
I ZEEKIA IP thilt,

AT Clear entire system /572 /5, SmartCheck Z4. ProLink ¥4 L FRBEEEAEH.
tﬂ EERRER %A, AIRATIAE:

o & Update firmware! & {F&i0E & XM E & £,
o @il Restore system| 331 {F— P Z A QIR LB X HS BN REMBE L% L,
IR BBV AT EGE T MnDhAE, W SR AR INIX EEVFaTE | 4,

4.6.4 Start remote access service: i3 RAS B 3im 21 i1
/i Start remote access service (] B4l FFRZIIThEE, AT AR ZFROALE FTP/Telnet AR % 2518 BhiZ TN EE

IRt Maintenance System AERIEEBRN, EJE SmartCheck &4, Prolink %42 J5, 1453 Remote Access Service
(RAS, ZF2 Vi M ARS:)

it RAS FFIRIZFET A9 X

1. ik ok ¥ 1241, Bt RAS AR I
2. RAS UMIEHNE, RAKHIBNISE



% % B Maintenance System

FAG SmarnChed: -= Open Expert Menu-= Start Remote Access Service

»

Start Remote Access Service

Here you can start the remote access service (RAS). This function will enable
the support team to assist you via FTP/Telnet.
Click OK to proceed or Cancel to abort.

Wersion: 1.0.20 (Build: 394580-20160815221038)

4.6.5 Update Maintenance System: B $7 Maintenance System
mii Update Maintenance System ¥ 1241, FELTTIR, AJfE L £ —4> SM1 X {4, BEFT Maintenance System,

E 7 Maintenance System 5=

1. & Maintenance system file [ 12441 3¢ 12 % 257 F Maintenance System B9 SM1 35,
2. ITI SM1 X, G5 1 X435 50 #) Maintenance System AR :

FAG SmarChed: -= Updste Maintenance System -= Select File

»

Update Maintenance System

Maintenance System file: i smc_rescue_FAG_1.0.22 sm1

The selected file contains the Maintenance System 1.0.22 (Build: 20170502_164020-395886).

Click OK to upload the file or Cancel to abort.

v X

“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:50 minutes.
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WNEFTE ST EH Maintenance System, NIl th &3k 1548 X @40,
3. Rili 0K v %2411, B Maintenance System,

PATIZIHRERS AR B A A T 4t 3 IR 44 ZE SmartCheck 24 Prolink 54, SR EHILIZH
!ﬂ LI R, D6 004 % S ERA TR b

4.7 Backup system: &3 % 4t
mili Backup system & R, FRIZIEE, AIUERUE— N REX O XY, EHARFEYE. BEEMKIE. A&

Restore system| 33 DIEEvE #3F A — D% XHEIB £ R4, & £ 5%, LUESHIINEE L5 Z 21 SmartCheck
4, ProLink %%,

= RGMAR
1. MIEFHIRPIEFHFI RO RE:

FAG SmartChed: -= Backup System

»

Backup System

You can create a backup copy of your system, for archiving purposes or for
safeguarding firmware, configurations and data.

Select a backup type and click OK to start the backup or Cancel to abort.

Firmwrare with configurations and data hd

Version: 1.0.20 (Build: 394580-20180515221038)

BB LTI

Firmware with BT ZEI R B RARE. WEBIEHFHF %G,
configurations

(without data)

Firmware with BIIZIET AR E . RO EEFNEHE,

configurations and data
2. Fifi OK v 1R, FRIARTIL &R KB I Fr B L IR AE,

3. [WTREMXM, EEFEMERRRIEILE,
4. WBRRGEREFE M BT, RERITERCA T 0 kR *.SCBK %173 XX .



% % B Maintenance System

MHIEEME, B4 Firmware with configurations and data ‘LRI ATREIEE K, THE
!ﬂ BN AR ], T T EHAN, R BRThEEIA 24NN 10 2241, AREIH,

4.8 Restore system: {8 £ 2 4;

& il Restore system L AT, FFR UL, BRI LI VE 3% 2 ATARM A A o), BE RS K OXHNEE
BEHEEREEEEN RS, BEH. BEEMEIE. Hlana] LUF— D &3 38 m#E — 4 ##9 SmartCheck 4. ProLink
Wk, B AR, b4, BRILERS A X RRERAEFEZ N RA L,

BREERGHAR

1. il Select file MW 124713t % 2 A ER LM SCBK X4,
2. $TFF SCBK STH. T %0507 STIE 325 KN 1 ST 440 & AT WD LE EL 4 -

FAG SmartChed: -= Restore System -= Select File

»

Restore System

Backup file: [@F f4_3d_80_00_0d_ce Backup.scbk

The selected file contains the firmware 1.9.17 (Build: 392442-20160212111841).

Click OK to restore the system or Cancel to abort.

v X

Versicn: 1.0.20 (Build: 3824580-201680815221038) Firmware 1.12.0 will start automatically in 9:45 minutes.

MRFTIEXHFEF AR LM, NBRRGHEXER,
3. mili OK v il RARSWERIEEERBHIEE, UEEERS:
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FAG SmarnChed: -» Restore Systemn -= Restore Configurstion

()
Restore System
Do you want to restore the backup to a replacement unit or an additional unit?
@ Replacement unit © Additional unit
The selected file contains the firmware, the configurations and also measurement data.
Do you want to restore the measurement data too?
Restore measurement data too
v X
“ersion: 1.0.20 (Build: 384580-201680815221038) Firmware 1.12.0 will start automatically in 8:41 minutes.
B LTI
Replacement unit NBREFAXMXEE—BEARF LETZRE, WIEHEZED, NRATE&G
Xt S FNMEHE, Nth£HI Restore measurement data too %5 (W T 5l
DI
Additional unit MEBEFEAAD X REGNEE £ FIZHE SmartCheck E4. ProLink %% L, N
TH R IZIL I,
Restore measurement NETHERTF B RH %%
data too . FEEAXHRTEEEHNRELZN, CSHIENRE B
o HET Replacement unit L5,
BUEIRL, LME—RHE & K10 X a0l E8E .. BUAER T2 TERKS, B8
RGN F DR SRR,
4. it OK Y sl BINEROILEESETFIME 1 4K

) o WNRTEFEZ)Z G Restore System Thakeh b, & FEH BT SmartCheck 24, ProLink &
g‘ % k., E5h SmartCheck Z4. ProLink % J&, Maintenance System $TH ., AF I EHEH £
#HZE %% E, $1n@id Update firmware = Restore system Ih&E,

o QISR FHF EFAHENAR, FTU—TE O XEHFHFSHHIMME ik, i0RE L
Restore system {5 %3 3C# £ E— s £, W& BRI 2 ik fREF AL

4.9 Reboot system: EE & 4

mii Reboot system @ R, FFB IR, AT LUEBN L ThEE R MRS, RBER . BLt46%E B 3) E B RTRIT T [H],
Maintenance System BITE 5 88 DhRE 18R TEZ I i),

ait ok ¥ i, BIER.



A LAFE Maintenance System B9 & 1L R R EZIIEE,

% % B Maintenance System
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EEHROTERP LEARFNAESFTFR D1200 HF4.

8.7.2.5.1 =ZEH M GX Works2

HIR 1 HBEEFRPHRERE
B WELS Schaeffler SmartCheck 4. ProLink & & #HTEEFMENFRIES
1. #TF GX Works2# 4,
2. i Project > Open,
3. TFERIRERFAEMIIE,
4. ESME DS W Parameter > PLC Parameter,
) Paramekber Setting

PLC Mame |PLC System |PLC File |PLCRAS |BootFile |Program |SFC | Deviee |10 Assignment | Mulkiple CPU Setting  Builk-in Ethernet Port Setting |

—IP Address Setting Open Seth
pen Setting

Input Format IDEE 'I
FTF Setting |

P Addiess IEEEEE S
Tirme Settifg

Subnet Mazk Pattern | | | [ |

Defaul outer P Addess | ! ! | || satiritis needed] Defaul / Changsd |

5. 7Ei&¥i-+ Built-in Ethernet Port Setting & #.; Open Setting.
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6.

7.

Built-in Ethernet Port Open Setting

IP Address/Port Mo. Input Format  |DEC -

Protacol Open System TCF Connection H T:,séﬂs ;?g?n II:)F'E;?Idn d‘?gz: DSE&'{?‘?”
1 |UDP * [MELSOFT Conrection  w hd
2 |TCP * [MELSOFT Conrection  w hd
3 |TCP * [MELSOFT Conrection w hd
4 |TCP ~ [MELSOFT Conrection  « hd
5 |TCP = |MELSOFT Conrection « hd
6 |TCP = |MELSOFT Conrection « hd
7 |TCP * [MELSOFT Conrection  « A
8 |TCP * [MELSOFT Conrection = A
9 |TCP * [MELSOFT Conrection = A
10 |TEP * |MELSOFT Connection = hd
11 |TCP * |MELSOFT Connection = hd
12 |TCP * [MELSOFT Conrection  w hd
12 |TCP * [MELSOFT Conrection  w hd
14 |TCF * [MELSOFT Conrection w hd
15 ITCF > IMELSOFT Conpection = hd

| 16 [TCP = [MC Protocol - - 1280

{(*) IP Address and Port Mo, will be displayed by the selected format.

Please enter the value according to the selected number,

End

Cancel |

PITTHNEE :
Protocol

Open System

Host Station Port No.

mii End LN KE,

TCP

MC Protocol

it - 1280 (48 F Xk :0500)




BCE

) Paramekter Setting

PLC Mame |PLC Systern |PLCFile |PLCRAS |BaotFile |Program |SFC |Deviee |10 Assignment |Multiple CPU Setting  Built-in Ethernet Port Setting |

— IP Address Setting

Open Setting

Irput Farmat IDEC 'I
| | FTP Setting |

IP Address 172] =8| zos[izz

Time Setting

Subnet Magk Pattern | | | | |

Default Router IP Addiess | | | | |

Setifitis needed] Default / Changed |

"Communication Data Code

% Binary Code

‘ = ASCH Code

I ¥ Enable online change [FTP, MC Protocal)

[ Dizable direct connection to MELSOFT

[~ Do not respond ta search for CPU (Built-in Ethemet part) on network

Prink \Window, .. | Prink Window Previews | Acknowledge XY Assignment | Default | Check | End Cancel |

8. 7 Communication Data Code i T X &£ #i#& =\ Binary Code,

9. & Enable online change (FTP, MC Protocol), M A {F Schaeffler SmartCheck 4. ProLink $iEE A £l 2R
F,

10. i End,
11. [FEFEAE Task /1,

115



116

ﬁn‘; MELSOFT Series GX Works2 E\_allm'\_Um\IFAG_SLMP_Test\neuw.gxw - [Task Setting Task_01 ]

g =

! Project Edit Find/Replace  Compile View Online Debug Diagnostics  Tool  Window Help -8 X
A= = =17 T it By Ean A DR EREY| S S SPRT AET S e 2
B EssIET R TR 38 el £ PR AN
i Navigation fx &1 POU [PRE] Program [S'Ij/'TaskSetﬁngTask_ﬂl ® l 4 F =
Gomen :
B YETE i
[]--% Parameter 9
Inteligent Function Module 4
- 4% Global Device Comment 5
[—]--@ Global Label =
+-42 Globall 7
Ee Global_Vars 3
E=l-f Program Setting 9
¢} Iritial Program 10
&1l Scan Program 11
=l MAIN 12
=i Task_01 13
-{gd) POU 14
-{{lf} Standby Program 15
ﬂﬂ Fixed Scan Program 16
-{{} Mo Execution Type 17
=4 pou 18
E@ Program 19
= POU 20
Program 2
i %Local Label 72
{23 FBJFUN P
I'_—'IE Structured Data Types 4
B smartCheck_172_28_205_46_T 75
@ Local Device Comment 2%
- Device Memory 27
g Device Initial Value 28
9
e ANER T A | B | le
English Structured Qo3UD Ul

12. @it EF itk FCompile > Rebuild AlILUEIC4if2F .
13. [FREF LM EETIER.
7£ Schaeffler SmartWeb # {4 d 4k 4L ER & 15 ) 25

%1% 2: 7 Schaeffler SmartWeb {4 b 7 iz 41 28

#REREE HTaT FNTHFES, ZRASESIRESFIT SRR EEERE:
o HEE—THREBEFENEOIBRBES BENEF,

o EEZMHRBIZEIEFIBMLUTESR:




BCE

A EEE
Schaeffler SmartWeb

g #5: BCH Mitsubishi Controller (SLMP)

LaEETEERT

2: EC® Mitsubishi Controller #H:| PLC_018 9
(SLMP)

IP Mk ;| 17228 205122

|mO:| 1280
EE
| TGP -
SRS | Binary -

E

Hit
a3
1

& Mitsubishi Controller £7 — -

VEEHEEFMBMOLLE

THEEE B E Tk Eel
2 ¥R PLC_018
IP il 172.28.205.122
prm| +i - 1280 (482 F+ 73l : 0500)
X TCP
fEHER =ik

EEE RN/ SRR RR O R B X F AR RS E SRR,

FEMERIFUE, TR ERNR MRBUMRERSEM, WBIENBAES.

g

$ 1B 3: 7 SmartWeb %44 i i hn e &l 25 #9580 A i
#EEFEEMNHALG:PLC_018 Wi T A Ml A & FMMAl B0 TUTRE:
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wmE@A

Schaeffler SmartWeb

£ | FESPLC_0MBRIEE

TSR | D000 (7]
WL | WORD ~| @
BEE: a=Ez v | Bfir:| RPM - | @
ERER: | 1% ~ @
ESE: RPM
B [RPM] : 20o=s
163,837 -
B )
16.38 100E3
B/p [RPM] : -
0.0 o=
E3 4E3 5E3 BE3 10E2
B|AFE jone e
e 0.0 10,000
&% k3% PLC_018
NEEHFHR D1000
e R E il WORD
LR v AR [ iR
L& RPM
HHEE 1% Max B {E &y 10000,
SEE £5%F Min 1  AZR{E 0 4% Max i AZ{H 3000,

RETTE N0/ S 55 2R 1) 28 RO 5 A 3 [ 10BEE 5 th R B 3 F AR R N SR i A IR E ZE A,
o IR B Schaeffler SmartWeb #4413 T % Ak, WA LI BoR [ il 2B 5

!J Schaeffler SmartCheck 4. ProLink ¥ # WK #1E .
o tE% A iR AT AN PR ER A S — AR TR U 2 4E 55 R T E

H IR 4:7£ SmartWeb 4 th 1 2422l 35 40 % HH 0
7 BEEEME R PLC_018 i T A 818 #H £MFME— TS HERUTLUTRE:
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el

Schaeffler SmartWeb

2
1: RS E

T RETFEET

TEgE

MEEFFR
B
A AR

EW ERTTENEEE

FISHEIFE © EESTE:

01200

01208

FEHEE

60 %

FHEEER:

TABEEE BERT
< EERE
~ 4 GEREHT v

— @& Base measurement job ol

@ aTLEEESY
@ T ATy b (EES

& 1S010816-1 (2Hz - 1kHz) - EE v

Q—ste—E—F - Ink (@ HE. ) v

1
o

D1200
T L5 TE 1B RSO/ B 1% i E R 2R AR,

REHE

BCE

®

B E AP B A S LA PR ER S I 41 %) ISO 10816-1 $FHE(HE PR EIR AT

BRAEL o XS I3 R R T R BNV

FEA SHE = R B EIHES B ) T B FRR B PR, (ERI7E 00/ 4% 48 R I 35 B A H 0 [ 105384 % 31 ¢ F anfar )
BEEAERNHIRNEENESER.

S 5. 5354 1045|850 A B T R E SmartWeb #f
1. 75 e BB R s rh o T S A o' S22 32 (5130 : PLC_018) ,
2. md ¥ TREA TR AR RN A E T,

3. THEEXH:
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Q

IEw GEV HESE Y BA v = v

Schaeffler SmartWeb

ER BiREE a8

T 0 2019-12-17 12:23:04
1 2019-12-17 10:27:18
. : admin

&IK: PLC_013 il

¢

S
O: 1280

Wl TCP
7. Binary

26.205.122

|

orc OPC UA server i

M PLC 018 (*SOFTCONTROL:

— =T VERSION:7.04.01%)
BT BEEHEMSA : PLC_0M8 TYPE

+ @@ SmartCheck 10_170 § 82 T:

B WWFFE SHE. BRAR BAE5| STRUCT

config_version: INT=1;

s_kommunikationsstatus: INT=0;

a_geratestatus: INT:=0;

a_basiskonfiguration: INT-=0;

END_STRUCT;

END_TYPE

VAR_GLOBAL

SmartCheck_10_179_8_82 AT

/S OEE - HE + FH @%MW0.1000,%MW0.1001,%MW0.1002,%MW0.1003":

SmartCheck 10 179 § 82 T;

END_VAR

Velocity from PLC_018 D1000 WORD 1.0s 0.0

BfERENSE : PLC 018

PROGRAM POU

**)

4 *%)

VAR_EXTERNAL

=7 SmartCheck_10_179_8_82: SmartCheck _10_179_8_82 T:
D1203 a_crest_factor_acceleration_imp Default configuration Cresi -IE_:\'D_\AR

D1204 c_crest_factor_acceleration_imp  Default configuration  Crest EsgDY

n1206 A isn1081R 1 10hz 1khz velncite Default confiuration 15010 MOVP( SM402, 1, SmartCheck_10_179_8_82.config_version )
L o END_BODY

s OoEE — @ik | END_PROGRAM

FHE AFEERE HEBEE

D1201 s_communication_status

D1202 a_device_status EEFERTE

CONFEIGITRATION arConfionration *

4. BT CTRL+A EFFHEOMANE, Bid CTRL+C [FH & HIEH Ntk HEid CTRL+V FHHFME— N miEacT (5
#n Microsoft Editor) .
5. FRAXHREN ASC HEER MR (Hlan: SmartCheck E4. ProLinko1.asc),

o INEFEMAIE Mozilla Firefox J%as, WA EEEL BENFXEREN ASCIT X,
9/ o EHAENIHMIES N JASC, IXFEF RERE GX Works2 #442EY,

H I 6:i% A GX Works2 HHIFEE X

1£5 A Schaeffler SmartCheck E4. ProLink BRE X Z Bl e &AL E W H .

Gl

1. ¥ Project > Open Other Data > Read ASC Format File,
2. S FEEIEM ASCII X4 (LASC) 34t %E,
3. A Schaeffler SmartCheck Z4. ProLink B2 & X {4, 3 BFE# il AYEN#HY Global Label, & %54 Global_Vars .
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ﬁ MELSOFT Series GX Works2 ..bishi',SonstDemosteverung’ FAGYFAG'FAG_DEMO_Rack - [Global Label Setting Global_¥ars ]

BCE

I Project  Edit

AN XBE

Find/Replace

i Navigation

Compile  Wiew  Online Debug  Diagnostics  Tool  Window  Help o ER
| B R e g e | ) e S e ) Lo B
eEERB T il e #mlissXEEDLo &S
" x £ Lacal Label Setting POU_01 [PRG] ]’ﬁpou_m [PRG] Program [Structured./ &2 Global Label Setting Global... ] 4 b

M [ Clazz Label Mame Data Tupe Constant Device 3
\ 1 |VAR_GLOBAL = |SmartCheck 172 28 205 46 |SmartCheck_172_28 205_46_T Detail 5 etting Detail §
[F5a o B 21| M : =
{5 Parameter 3 -
[H-{ad Inteligent Function Module 4 -
-l_} Global Device Comment 5 -
E-{§5 Global Label 5 -
42 Globall 7 -
Ay Global_Yars I -
- Program Setting 9 -
B Pou 10 -
{1 Program 11 hd
- PoU_D1 12 -
-] Program 12 -
- g Local Label 14 -
15 2
16 hd
1B} Structured Data Types 17 -
1) Local Device Comment 18 -
[ Device Memary 19 -
----- Device Initial Yalue 20 -
21 2
......... = -
Jﬁ Project 23 =
24 2 -
L.‘.I User Library | o | ;I
g System Label Dperation *To reflect the cha
Connection Destination f
Change C] Reqister Release system label databa
C]E>IE Motification IFAReE | <::I Device Mame Relation please save the pro
»
2 | i
Skructured QOEUDEH Host Station Line 1 Col. & T
£+ Device B #.1l; Detail Setting I, 135 R EHSHEXEES:

Structure Device Sekting E

SmartCheck_172_25_205_46

{SmartCheck_172_z8_205_d46_T)

Label Hame Data Type Device Address 1=
config_wersion word[Signed] Rag Zhiw/2 98
device_status “Word[Signed)] R100 bW 2100
standardmeszaufgabe ‘word[Signed] R101 Zhiw/2100
igol 0816_1_10hz_Tkhz_gf*ord[Signed) R102 Ehwi2 102
communication_status “word[Signed] Ra3 Zhiw/2 93

l

Ba

v auktomatic Filing

vV Use Bit Designation

= |

Cancel |

SR 7L RIEFFEREEHE
1. BT EFE AL Compile > Rebuild AlLUEIC 2R,
2. RGMREFFGEAMEEGR,

8.7.2.5.2 =##4 GX IEC Developer

L1 REEHEPEERE
B % ikE S Schaeffler SmartCheck 4. ProLink ¥ & TBIEFMEMFTES

1.

2.
3.
4

$TFF GX IEC Developer#iff,
¥ Project > Open,

$TFF 4% Schaeffler SmartCheck 4. ProLink BRE XS AR FHIE
% 5% 0O Wil Parameter > PLC Parameter,
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) parameter setting

FLC name |F'LE zystem |F'LC file |F'LC RAS |Device |F'rogram |Boot file |SFC |IHD azzignment  Built-in Ethernet port

—IP address

IP address
Subtet mazk pattern

Default router IP address |

Impuit Farmat I DEC j'

I Open zettings I

172]  2g]

205]

FTP zettings |

122]

Time sattings |

5. 7Y+ Built-in Ethernet port &3 Open settings.

6.

7.

Setifitis needed] Default ¢ Changed |

IP Address/Port No. Input Format  |DEC 7
Protocol Open System TCP Connection H%ifﬁjlon ?::h; ;rzz: DSEE:;&?”

1 |UDP ¥ |MELSOFT Connection - -

2 |TCP ¥ |MELSOFT Connection - -

3 |TCP ¥ |MELSOFT Connection - -

4 |TCP ¥ |MELSOFT Connection - -

5 |TCP ¥ |MELSOFT Connection - -

6 |TCP ¥ |MELSOFT Connection - -

7 |TCP ¥ |MELSOFT Connection - -

a |TCP ¥ |MELSOFT Connection - -

g |TCP ¥ |MELSOFT Connection - -

o (TCP ¥ |MELSOFT Connection - -

11 |TCP ¥ |MELSOFT Connection - -

12 |TCP ¥ |MELSOFT Connection - -

13 (TCP ¥ |MELSOFT Connection - -

14 (TCP ¥ |MELSOFT Connection - -

15 _(TCP > |MFLSOFT Connection hd hd

16 |TCP  |MC Protocol - - 1280
(*) IP Address and Port No. will be displayed by the selected format.

Please enter the value according to the selected number,

End I Cancel |

PITTINEE -
Protocol

Open System

Host Station Port No.

TCP

MC Protocol

mii End LN KE,

3 : 1280




Q) parameter setting

FLLC name |F'LE aystem |F'LE file |F'LC R&S |Device |F'rogram lBoot file |SFC |IJD azzignment  Built-in Ethernet port

 IP addre:

Open settings |

Input farmat IDEC

=

IP address |

172] 2]

205]

122]

Subret mazk pattem [

Default router P address [

r— Communication data code
' Binamy code —‘
¢ ASCH code ‘

[¥ Enable online chanoe [FTP. MG protocal]

[~ Disable direct connection to MELSOFT

[~ Do not respand to search for CPL [Built-in Ethernet port] on netwark,

FTP zettings |
Time sattings |

Setifitiz needed] Default # Changed |

Acknowledge # assignmentl Multiple CPL settingsl Default | Check |

End | Cancel |

10. #. End,
11. FEFEESE Task f1,

ESmartCheck_IEC - GX IEC Developer - [MAIN_LD (Prio = 31, Event = TRUE)]

7 Communication Data Code i T % &£ 4i#£ = Binary Code.
;% Enable online change (FTP, MC Protocol), Mifia] 7£#% 25 & 5 A Schaeffler SmartCheck E 4. ProLink %k
.

] [=] P4
JE Project Object Edit Tools Onlne Debug View Extras Window Help ;Iilﬁl‘
R ESR[(% B8 D[ Shin e | CHB D wwma |E
SmartCheck IEC S| POU name Comment =)
Project [C\FAG\SmartCheck_IEC] 0jPouU_01
Lff‘ Library_Pool

Parameter

G PLC

- Network

Ml Module Configuration
-4 Task_Pool

Ty [MAIN_LD (Prio = 31, Event = TRUE)]

=84 DUT_Pool
w33 Smart_Check_172_25_205_46. T
..... '@ Global_vars
=& POU_Pool
-8 POU_01 [PRE]
g Header
Lo} Body [LD]

& Project |92, caltree | 92 used by |

Ready

[ % 17:37 [TASKMAIN_LD: Event TRUE, In |Q20UDEH

12. @it EFE A rhik it Compile > Rebuild AlLLUEIC 2R,

13. R 1A EEHER

7£ Schaeffler SmartWeb {4 R &

2 2R o
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%1% 2: 7 Schaeffler SmartWeb {4t 7 hniZ 41 28
#RERE T AT FNTFES, ZRASESIRESAIT SRR EEERE:
o EFE—AFRPEFENECEBREREMIEGIZE.
o EE_ATRPIREIEFBHLTER:
B

Schaeffler SmartWeb

g #5: BCH Mitsubishi Controller (SLMP)

1 EEESEEST

2: EC® Mitsubishi Controller #H:| PLC_018
(SLMP)

IP Mk ;| 17228 205122

|mO:| 1280
EREE
| TGP -
SRS | Binary -

T

EEL¥ Mitsubishi Confroller £9

% BR A BE iz g ask 1 (1] T
NESEEFAROUE

SEinE EE ==
2 PLC_018
IP Hhit 172.28.205.122
i m) i3kl : 1280 (4B F+7XiEH:0500)
Pl TCP
st Z

EEE RN/ SR PR RR [0 R B X F AR RSB E SRR,

FEMERIFUE, TR ERNR MRBUMRERSEN, WEIENBAES.

g

$ 1B 3: 7 SmartWeb %44 i i hn e &l 25 #9580 A i
7 EEFEEMNHALG:PLC_018 i T A Ml A & FMMAl B0 TUTRE:
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BCE

wmE@A

Schaeffler SmartWeb

£ | FESPLC_0MBRIEE

TSR | D000 (7]
WL | WORD ~| @
BEE: a=Ez v | Bfir:| RPM - | @
ERER: | 1% ~ @
ESE: RPM
B [RPM] : 20o=s
163,837 -
B )
16.38 100E3
B/p [RPM] : -
0.0 o=
E3 4E3 5E3 BE3 10E2
B|AFE jone e
e 0.0 10,000
&% k3% PLC_018
NEEHFHR D1000
e R E il WORD
LR v AR [ iR
L& RPM
HHEE 1% Max B {E &y 10000,
SEE £5%F Min 1  AZR{E 0 4% Max i AZ{H 3000,

RETTE N0/ S 55 2R 1) 28 RO 5 A 3 [ 10BEE 5 th R B 3 F AR R N SR i A IR E ZE A,
o IR B Schaeffler SmartWeb #4413 T % Ak, WA LI BoR [ il 2B 5

!J Schaeffler SmartCheck 4. ProLink ¥ # WK #1E .
o tE% A iR AT AN PR ER A S — AR TR U 2 4E 55 R T E

H IR 4:7£ SmartWeb 4 th 1 2422l 35 40 % HH 0
7 BEEEME R PLC_018 i T A 818 #H £MFME— TS HERUTLUTRE:
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el

Schaeffler SmartWeb

2 R ERTTE I EE

1: RS E

2 EEEERET mﬁ;ﬁ* : RETER: o
!ﬁﬁ:ﬁ?‘: . 9
RS 9
WA B EE RERS - RERE
< BERSE -~
wE - b EEREED 7
— @& Base measurement job ol
Q2T LEER T
@ T Ty b (ESES
Q an v
@ RMS Z
@ RMS ZEE -1 7 2)
& 1S010816-1 (2Hz - 1kHz) - EH v
QS e——5  IniE (EESHE. ') v v -
THERE *i Exd
MIRTHFHR D1200
BEHFMR IR E R BRSNS E M L i E E R SRR,
A AR E Bt B AR B A S 4 R PR ZAR S FF 41X ISO 10816-1 HHiE EiE R AR AN

BRAEL o XS I3 R R T R BNV

FEA SHE = R B EIHES B ) T B FRR B PR, (ERI7E 00/ 4% 48 R I 35 B A H 0 [ 105384 % 31 ¢ F anfar )
BEEAERNHIRNEENESER.

S8 5.9 B A S| 8% IR E R E SmartWeb
1. 75 " BEEE RS h S AT A o 58 (5140 - PLC_018).,

2. md ¥ TREA TR AR RN A E T,
3. HAFEREXH:
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Schaeffler SmartWeb

Q

BCE

Arw fF v MEEE Y ZA VY B w
BN BfEEE B
H: PLC_018 fi | 7. 2019-1217 12:23:04
| : 20191217 10:27:18
Bt <.) . : admin
1 172.28.205.122
O: 1280
Wl TCP
fE3® e . Binary t
= - PR = = ] X
orc OPC UA server £ R = =
M PLC 018 ("'SOFT&?}“IROL‘.
Rt BEBEGRA : PLC_018 ;_E;*ESIOA 17.04.01%)
+ @@ SmartCheck 10_179_8 82 T:
a2 WHTHFE FHE. ERAR BAMES| STRUCT
: config_version: INT=1;
Velocity from PLC_018 D1000 WORD 1.0s 0.0 s kommunikationsstatus: INT-=0
a:gcrar:stams. INT:=0,
a_basiskonfiguration: INT-=0;
END_STRUCT;
END_TYPE
VAR_GLOBAL
) ) | SmartCheck _10_179_8_82 AT
/S OEE - HE + FH @%MW0.1000.%MW0.1001,%MW0.1002,%MW0.1003":
SmartCheck_10 179 8§ 82 T;
BfEAEENRL  PLC 018 END_VAR
PROGRAM POU
AIFE AFEER HEEFE [y
e ¥ K g
D201 s_communication_status . o VAR_EXTERNAL
D1202 a_device_status EERENE %1 SmartCheck_10_179_8_82: SmantCheck_10_179_8_82 T:
D1203 a_crest_factor_acceleration_imp Default configuration Cresi -IE_:\'D_\AR
D1204 c_crest_factor_acceleration_imp  Default configurafion  Crest EsgDY
1206 a isn10A16 1 10hz 1khz velacite Default confiouration 19014 MOVP( SM402, 1, SmartCheck_10_179_8_82.config_version )

7 BE

END_BODY

# END_PROGRAM

CONFEIGITRATION arConfionration

4. @it CTRL+A EHHEOMASR, @id CTRL+C FH & HEF iR+ @1 CTRL+V FEFME— %4285 (6

#n Microsoft Editor) .
5. ERAXHREN .ASC HEE

L MR E ST (140 : SmartCheck 24, ProLinkol.asc),

o INEFEMAIE Mozilla Firefox J%as, WA EEEL BENFXEREN ASCIT X,

Gl

H I 6:3% A GX Works2 HHIEEE

X

o IHHAEXHHIES ASC, IXFEF RERX GX Works2 i i5:8R,

1£5 A Schaeffler SmartCheck E4. ProLink BRE X Z Bl e &AL E W H .

Gl

1.

.1 Project > Open Other Data > Read ASC Format File,

2. FiEBEOIEM ASCII X (LASC) HHHHERE.

3.

B2 A Schaeffler SmartCheck 4. ProLink EZE X #, 3 BEM il A{EA#THY Global Label, %75 Global_Vars .
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128

T3 smartcheck_IEC - GX IEC Developer - [Global Variable List] ~=lolx|

Iﬁ Project QObject Edit Tools Onlne Debug View Extras Window He\p =8|
lzl8k: meo s = g

SmartCheck IEC:JJ Class Identifier MIT-Addr. IEC-Addr. Type =
Project [C:\FAG\SmartCheck_IEC] + 0|VAR_GLOBAL »|Smart_Check_172_28_205_46 |config_version: R98 [config_version: %MW2 |Smart_Check_172_28_205|__

I il vLibrary_pool
E| @@ parameter

Network
.. Bl Module Configuration
L@ Task_Pool
H €Ty MAIN_LD (Prio = 31, Event = TRUE)
E 3§ puT_Pool
i 33 smart_Chedk_172_33_205_46_T
----- .| g Global_Vars
& a3 PoU_Pool
E-88 POU_01 [PRG]
g Header
Lo} Body [LD]

5 Project [eE, caltrea [ 9= Used by J

| o
4

[ €3 17:34 |GVL: 1 Dedarations |@20UDEH

1££% Device 1 #.1f; Detail Setting I}, 13 2 RiFMHEHSHXFES:
x

Smart_Check_172_28 205_45 (Smart_Check_172_28 205_45_T)

Mame Type | MIT -Addr. | |EC-Ayddr, 1=
1 |config wersion wWORD R393 ZMW2.93
2 |device_status WORD F100 ZMw 2100
3 | standardmesszaufgabe WORD R101 EMw 2101
4 |izo10816_1_10hz_1khz_g ‘WORD R102 Ehwi2 102
5 | comunication_status WiORD R33 ZMw/2 33

14 [ ]
¥ futomatic filing ¥ &l Types Export Import | Ok I Cancel |

BB 7 ILmEFFIEMEEHE
1. BT EFEA G Compile > Rebuild AlILUEI 432
2. &PUREFFFEEHMEENRE.

8.7.3 AAF OPC UA R % 2R HIE 5 EE

OPC UA 2— R LASEHL ¥ 4% ()@ (S F$0HE R e bbb . 72 °°° 1588 (OPC UA IR%-38) 'SRt M, (RAIELE
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